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Chapter 3. Software Reference Guide 
EasyManager and PLCAddressView are software used for Easybuilder 500. We will introduce them 
one by one. 

 
 
 
3.1 EasyManager 
 
Easy Manager is the comprehensive software of system of a whole set of WeinView500 software. 
There are three modules in the whole Easybuilder500: Easyload [Upload & 
Download],EasyWindow(On-line Simulator & Off-Line Simulator) and Easybuilder. Easybuilder is 
the software for editing,Used for planning various kinds of component positions,Generally 
abbreviate as EB500. You can download and simulate on line (or off line) by using EasyManager 
that is realized by the way transfering other two mould groups via EasyManager. Don’t need to 
open EasyManager window downloading or off-Line from EasyBuilder. But you have to set up 
related parameters on EasyManager(ex.COM port, communication speed),otherwise the operation 
may be unable to run. 
The structure relation diagram of EasyManager depicts as below: 
 
 

EasyManager
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Select Start/Program/ EasyBuilder/ EasyManagert,the popup EasyManager dialog appears as below: 
EasyManager has the following components: 

 
In EB500 the communication parameter between the computer and HMI is defined as follows: 
COM Port Drop-Down Box: 
Select the number of the RS232 Serial COM port ,COM1 or COM2 for computer.(Ports COM1 
through COM10 are available for selection.) 
 
Communications Speed Drop-Down Box: 
Determine the communications speed between the PC and the unit during downloads and 
uploads,the 115200 speed is recommended. (For old style machine or special requirement, the 
38400 speed is recommended.) 
 
Project Download/Upload or Recipe Download/Upload: 
Select Project Download/Upload to transfer project data. 
Select Recipe Download/Upload to transfer recipe data. 
 
Complete or Partial Download/Upload: 
Selecting Complete to download both program file (*.eob) and system file (*.bin) is slower than 
select Partial to download just only program file(*.eob). When uploading, speeds are the same to 
select either Complete or Partial. 
 



 
Easybuilder: 
EasyBuilder is the software for editing,Used for planning various kinds of component 
positions,Generally abbreviate as EB500. Push this button can enter the editing picture of EB500 
software. Please consult this seal of section five about the detailed introduction to this software. 
 
Online-Simulator: 
Simulator can read the data of PLC through MT500 after a project is compiled by EB500.( This 
creates a file with extension*.eob) and you can operate directly on computer by MT500.  
Using Online-Simulator function saves much time for repeat downloading. Please refer to Ch. 6 for 
detail.  
 
Offline-Simulator: 
The Offline simulator emulates the operation of a project on the PC screen which retrieves the static 
data from display. Please refer to Ch. 7 for detail. 
 
Download: 
Download a project compiled by EasyBuilder to the MT500. Please refer to Ch. 2 for detail. 
 
Upload: 
Upload the project file from MT500 to an object file (*.eob). The upload file can’t be opened by 
EB500 but can be transferred to another HMI. On the other words, the upload file can be transferred 
among the HMI with the same program. Please refer to Ch.3 for detail. 
 
Jump to RDS Mode: 
Jump to RDS is used for on-line simulations or far-end error detections. Uploads and Downloads 
are done in this mode. You also can search system’s ROM version or some system information. 
 
Jump to Application (State mode of the application program) Mode: 
This is the normal operating mode of a unit. Clicking Jump to Application runs the project in 
memory. If there is no project (or the project is broken) in the unit , the unit jumps to RDS Mode 
after booting. You can download a complete project to HMI and then return to operation mode. 
 
Jump To Touch Adjust (Touch screen calibration) mode: 
Jump to Touch Adjust is used to calibrate the touch screen. Changing motherboards or displays have 
to use this mode to calibrate the touchscreens. MT 500 series shows the instruction to lead you to 
complete the calibration. 
 
The three buttons of EasyManager describe above can be forced into switch to the corresponding 
mode, far-end On-line operation mode and Touch screen calibration mode. 
 



 
Touch Test mode: 
Test touch panel accuracy. In this mode, when you touch the screen, there is a corresponding display 
“ +” on the point you touch which for you to test the accuracy. Note: This mode change isn't on the 
EasyManager menu, But it is done by changing Dip Switches. Please refer to Dip Switch chapter 
for detail. 
 
Exit: 
This button closes the EasyManager application. 
 
 
 
 
 
 
 
 
 
3.2 Download 
 
Before a project can be downloaded it must be compiled. There are two methods to process:one is 
through the download button of EasyBuilder ,another one is from EB500, select Tools/ Download in 

the menu bar or press icon to download 

 
(1)Downloading through EasyManager: 
Select Start /Programs/EasyBuilder/EasyManager. 



 

 
Set up all necessary parameters. Please refer to EasyManager part in this chapter. 
Click on DownLoad button. 

 
Choose the project file and then click Open. 



 

 

Downloading begins with the Easy Download dialog popping up and is tracked by the progress bar. 
After downloading, click OK. 
Click on Jump To Application button or reset the display to application mode, the project is 
operated on the display. 
 
(2)Downloading through EB500 
Open the [*.epj] file name of the project on EB500 or the current editing file, select Save in the Edit 
menu and then select Compile in the Tools menu. 
 

After compiling, close the compiling dialog. In Tools menu, select Download or press icon.The 

pop-up dialog appears as below: 

 

Click OK when finish. 
Click on Jump To Application button or reset the display to application mode, the project is 
operated on the display. 
 
(3)Downloading through CompactFlash memory.(for E4 series) 
MT500 E4 series support the function of downloading through CompactFlash memory. 
 
Step Task Picture 
1 After editing,compile and save. 

 



 
2 Click ImagCF icon from the programs list. 

 
3 

Click icon and open eob extension 

compiled from step1. 
 

4 ImageCF.exe program combines .eob file 
and related .bin file to a 
ImageCF.bin(Please don't use other name 
on this file.)  

5 Copy ImageCF.bin to the root folder of CF 
card. 

 
6 Insert the CompactFlash card into the units 

CompactFlashT slot.Put dipswitch 2 of the 
unit in the ON position and the others are 
all off. Then push reset button.The unit 
comes up in RDS mode and a green CF 
card button appears.  

7 Click the green button and then start to 
download. After download, the mode 
automatically switch to Application mode. 

 
The CF slot of MT500 may not detects all brands of CF cards. “San Disk”and “PQI”are suggected. 

 

The CF memory card may be formatted as FAT16 or FAT32. 
 



 

3.3 Uploading 
 
We can upload the project from HMI to PC and then On-line Simulation in the computer and 
download project enter other HMI to operate.The upload file must be *.eob which is not allowed to 
compile on EB500. Uploading isn't reached in EB500.Upload the project through EasyManager/ 
Upload. 
Open EasyManager, set up the corresponding parameters.The pop-up dialog shows as follows: 

 
Input the file name. Click Open. If the password is set on the project, it pops up a password message 
box. After the password is confirmed, the pop-up message box appears as below. 

 

Click OK after downloading. Find the file from the corresponding location and then download to 
other HMI or run On-line simulation. 
 
 
 
 
 
 
 
 
 



 

3.4 PLC AddressView 
 

 
Select and click PLC AddressView will show plc address type and range,The pop-up dialog shows 
as follows: 

 
Bit is a base unit,eight bits are one byte,two bytes are a word,two words are the Dword. 
d:Decimal,o:Octal,h:Hexadecimal 
Bit(HMI): HMI bit , Bit(PLC):PLC bit。 



 

 
The Address Type show different PLC address type and range. Usually, there are 4 data 
types Bit, Byte, Word, Double Word. 
1. Bit address type 

LB (Local Bit): Internal bit of the HMI. 
RBI: Recipe index bit. Please refer the CH8. 
RB: Recipe bit. 
Ms_RB: Master/Slave connect, the slave HMI can use Ms_RB to get the Master HMI’s 

RB data. 
Ms_LB: Master/Slave connect, the slave HMI can use Ms_LB to get the Master HMI’s 

LB data. 
ddd: Decimal address format 
ooo: Octal address format 
hhh: Hexadecimal address format  
ddd(h): ”ddd” word address in decimal format, ”h” bit address in hexadecimal format.  
ddd(dd): ”ddd” word address in decimal format, ”dd” bit address in decimal format.  
ddd(o): ”ddd” word address in decimal format, ”o” bit address in decimal format.  
 
Some PLC base address are 1. For example, Modbus RTU 1x and 0x address range is 
from 1 to 32767. Some Modbus RTU device base address is 0. So, the MT500 address 
have to subtract 1 to according the device address. Mitsubishi FX2n SM address type 
base address is 8000.  
Max and Min to mean maximum address number and minimum address number. 
 

2. Byte address type 
Byte address has 2 types, ddd and hhh.  
ddd: byte address in decimal format   
hhh: byte address in hexadecimal format  
Max and Min to mean maximum address number and minimum address number.  
 
 



 
3. Word address type  

LW: Local Word, the data in HMI memory. When the HMI power off, the LW data will 
reset to 0. 9000~9999 are reserved for system.  
RWI: Index to Recipe Word. Please see ch8.  
RW: Recipe Word. After the HMI power off, backup by battery. 60000~65536 are 
reserved for system.  
Ms_RW: Recipe Word located in the Master HMI. Slave HMI use Ms_RW to access 
Master HMI RW data.  
Ms_LW: Local Word located in the Master HMI. Slave HMI use Ms_LW to access 
Master HMI LW data. 
 

4. Double Words address type  
Double words address has 2 types, ddd and hhh.   
In EasyBuilder, No. of words select 2.  
ddd: address in decimal format   
hhh: address in hexadecimal format ddd 

 
 
. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

3.5 EasyBuilder interface 
 
Click EasyManager's EasyBuilder button or directly select Start/Programs/Easybuilder/ EasyBuilder 
500 in the menu bar. If it's the first time running EasyBuilder or a last blank project was opened on 
last time log-in, the following popup dialog appears. 

 
Select the type of display and then click OK to enter EB500 screen editor window. Or enter EB500 
to open the latest opened project.  
Select File/New to create a new project. The pop-up dialog appears as below. Select the appropriate 
type of display from the drop-down box and then click OK to enter EB500 screen editor window. 

                 
 
 
 
 
 
 
 



 

3.5.1 Screen Editor Overview 
 
The following shows the screen editor window. The function of each screen area are explained 
below. 

 
a. Title Bar: 
  Displays the project's file name, active window number and title. 
 
b. Menu Bar: 
  Displays the menu used to select EasyBuilder commands. There is a corresponding dropdown 
under each function bar. Each choice in the dropdown execute an operation. 
 
c. Tool Bar: 
  Displays the icons corresponding to File, Edit, Library, Tools ,Simulation and up/ download 
menu items. 
 
d. State Selector:  
  Selecting different state toggles all the parts on the window to the specified state. 
 
e. Alignment: 



 
  Makes all the selected parts line up to the top, bottom, left or right 
 
f. Size Adjust:  
  Makes the dimension, width or height, of all the selected parts the same size. 
 
g. Position Adjust:  
  Adjusts the position of selected parts. 
 
h. Group:  
  Makes a collection or combination of selected parts and drawing elements as one object. Save the 
group to the library for next time use. 
 
i. Layer Control: 
  Adjusts the Layer of selected part ¡V one layer up, one layer down, to top layer and to bottom 
layer. 
 
j. Text size & position:  
  Changes the font size and alignment of the selected text. 
 
k. Rotate and Flip:  
  Flips the shape horizontally or vertically and rotates the shape in 90-degree increments. 
 
l. Parts Tools: 
  Each icon represents each Part type. Clicking on one of these icons causes that icon¡¦s dialog to 
appear. That Part¡'s attributes can then be set and the Part can be placed on the screen. 
 
m. Window Treebar: 
   Provides quick access to Window properties or objects. 
 
n. Drawing Tools: 
  Each Icon represents each drawing tool. These tools include: line, rectangle, circle, arc, polygon, 
bitmap and so on. 
 
o. Cursor Position:  
  Shows the current cursor position on the active screen and assistant statements. 
 
 
 
 
 



 
 
3.5.2 Menu [File] 
 
1) New 
Select [New] from File menu or select to create a new project. 

 

 
Click OK, a new project is initiated. 
 
2) Open 
Select [Open] from File menu or select to open a exist project. 



 

 

 
Choose the selected project file and then click Open or double click that project file. 
 
3) Close 
Select [Close] from File menu to close the current project. 

 



 
All current windows are closed after clicking Close, the display shows as below: 

 
 
4) Save 
Select [Save] from the File menu or select to save the current project. 

 
The dialog shows as below if the project hasn’t been saved. 



 

 
Input the file’s name and click Save. 
If the project is saved before, click Save and there isn’t any dialog showed. 
 
5) Save as 
Select [Save as] in the File menu to save the current project to designate path. 

 



 

 
Input new project name to save the new project. 
 
6) Exit 
Exit EB 500. 
 
7) Current opened files 
Four current opened files’ names and paths are showed in the File menu. Click any file name to 
open the file. 
 
3.5.3 Menu [Edit] 
 
1) Undo 

[Undo] function cancels the latest operation and go back to previous condition. Press icon or 

select [Undo] from the Edit menu to cancel the latest operation. 
 
2) Redo 

[Redo] function revert current operation to previous condition. It's done by pressing icon or 

selecting [Redo] from the Edit menu. 
[Undo]/[Redo] function is used in adding or changing any object on the screen. 
Add one object as the 
diagram:



 

 
Click Undo. 



 

 
then click Redo. 
Note: Considering the size of the file, only the lastest action can be Undo/Redo. 
 
3) [Cut],[Copy],[Paste] and [Delete] 
Cut, Copy, Paste and Delete functions are available for all objects. The corresponding icons are: 

 
 
4) Multi-Copy 
Multi-Copy duplicates one object to many and arrange them in a certain way. 
Choose an object and select [Multi-Copy] from the Edit menu. The popup dialog appears as below. 



 

 
 
Pitch: 
The duplicates object is overlaps. 
Interval: 
The space between duplicated objects is the X and Y distance. 
RGT/BTM: 
The address type of duplicates is copied from left to right one row at a time. 
X: Horizontal Distance/ Y: Vertical Distance: 
The space of the duplicates are X and Y distance apart. 
Quantity X/Y: 
The replica object is in x (y ) quantity of the direction. 
Address Distance: 
This value adjusts how much the object's Address is incremented for each duplicated object. 
 
Example: 
Choose an object: 



 

 
The attributes of the object as follows: 

 



 
Select Multi. Copy from the Edit dropdown. The Multi. Copy dialog shows as below: 

 
Click OK and the result shows as the following diagram: 

 
Check the attributes of each object. The addresses of them from left to right are Y1、Y4、Y7⋯;and 
X and Y direction are each 3 objects. 
If the Multi. Copy dialog shows as below: 



 

 
Click OK and then the result shows as the following diagram: 

 
The X vector is 4 and the Y vector is 3.The addresses from top to down are Y1,Y5 and Y9. 
 
5) Window Copy 
EB500 supports the window copy function not only within a project but also among different 
projects. For example: 



 
< Within a project>As the diagram, there are two windows in a project: 

 



 

 
Select Window Copy from Edit menu, the pop-up dialog box appears as below: 

 
Click OK and then pop up a message box. Select OK. 



 

 
Window 10 is covered by window 11. Window 10 shows the same content as window 11. 
Similar way is used in copying windows among different projects. Browse the file (*epj) that has 
the window you want to copy or import. Fill in the Source Window No. from the *.epj project. 
Select a window number in the open project where the window is to be placed. 
 
6) [Layer] 

When many pojects layer one on top of the other,through pressing or selecting the [Edit] 

menu [Layer] submenu to change the order of the objects. 
Select object and An object may be brought to the front, back, front one layer at a time or back one 
layer at a time by choose a corresponding icon. 



 

 
 
7) [Nudge] 
Choose an object and the object position moves can be adjusted by nudging. Press the cursor keys 
on the keyboard to move an object or group one pixel at a time. Object position moves can be called 
from the [Edit] menu [Nudge] submenu and the corresponding icons are . 
 
8) [Align] 
Objects can be aligned by their left edge, vertical center, right edge, top edge, horizontal center, or 
bottom edge. Object alignment can be called from the [Edit] menu [Align] submenu or by clicking 

on the appropriate corresponding icons . 
 
9) [Make same size] 
When multiple objects are selected, they can all be fixed to the same size by using the [Make same 
size] function.Objects can be made the same width, height, or overall size. It can be done from the 

[Edit] menu [Make same size] submenu or by clicking on the corresponding icons . 

 
10) Transformation 
The one that can be turned is only a figure drawn with the drawing tool, such as the straight line, 



 
round, polygon ,etc., other components can not be turned. Select the object and the object 
transformation can be done from the [Edit] menu [Flip Vertical], [Flip Horizon] or [Rotate 90 

degree] items or by clicking the corresponding icons . 

 
 
11) Group/Ungroup 
[Grouping]/[Upgrouping] multiple objects or shapes can be called by this function. Grouped single 

objects can be used as a object or can be saved to the library for next time use. Click icon to 

gather multiple objects and click icon to break up a group into its seperat objects. Select 

[Library]/[Group library]/[Save to group library] to save the group. 
 
12) Redraw Window 

Redraw the window to show again,the corresponding icon is . 
 
13) [Select All Objects] 
A object can be selected by clicking icon in the drawing tools or selecting [Select] from the [Edit] 
menu. 
There are 3 types of selection: 1)[Select]: Select single object.  
                        2)[Select All Objects]:Select the all objects on the screen.  
                        3) [Select Next Object]：Select the object under the selected object 
Cancel the selected object: 
If many objects are selected and you would like to cancel some of them, move the mouse to the 



 
object ,press [Ctrl] key and then click that object to cancel the selection. 
Add the object: 
If many objects are selected and you would like to add another object, move the mouse to the object 
you are adding ,press [Ctrl] key and then click that object to add the selection. 
NOTE : Many objects or states are selected , just move the mouse and select someone of the object , 
press [Ctrl] key and then click that object to be selected. 
 
14) Change Attribute 

Double click on the object or click on the Edit icon  to call up its Attribute Dialog for editing. 

 
15) Change the size of the object 
By double clicking the object, the dialog of the object’s attribute appears. Select Profile to change 
the size of the object or by dragging the corresponding points to resize the object. 
 
 
 
 
 
 
 
 
 
3.5.4 Menu [View] 
 
In View menu, each selection controls the display of each toolbar. Basically, each function in the 
toolbar can be found in corresponding menu. 
 
1. Standard Toolbar 

 
As the diagram above, the functions to the corresponding icons are: 
[New]：Create a new object 
[Open]：Open a existing project 
[Save]：Save the current project 
[Cut]：Cut 
[Copy]：Duplicate 
[Paste]：Paste 
[Undo]：Cancel the latest action 
[Redo]：Return to the previous condition 



 
[Print]：Print 
[About EB500]：Detail of EB500 Version 
[Help]：Perfecting 
[Redraw]：Redraw Window 
[Grid]：Set grid on the screen 
[Snap]：Enable the snapping of objects to the grid. 
[Save Objects to Shape Library]：Save Objects to Shape Library 
[Call up Shape Library]：Call up Shape Library 
[Call up Bitmap library]：Call up Bitmap library 
[Save to Group Library]：Save to Group Library 
[Call up Group Library]：Call up Group Library 
[Compile]：Compile 
[On-line Simulation]：On line simulation 
[Off-line Simulation]：Off line simulation 
[Download]：Download 
[State bar]：Change the state of the object 
 
2. Manager Toolbar 

 
[Font]：Choose the size of the font 
[Font enlarging]：Enlarge the font 
[Font shrinks]：Reduce the font 
[Align Left]：When the content of the text exceeds 2 lines, the text is put according to the left aline 
way. 
[Center]：When the content of the text exceeds 2 lines, the text is put according to the center aline 
way. 
[Align Right]：When the content of the text exceeds 2 lines, the text is put according to the Right 
aline way. 
[Top Layer]：Set up object and lie in top layer. 
[Bottom Layer]：Set up object and lie in Bottom layer. 
[Previous Layer]：Set up object to Previous Layer. 
[Next Layer]：Set up object to Next Layer. 
[Nudge Up]：Make object Nudge Up. 
[Nudge Down]：Make object Nudge Down. 
[Nudge Left]：Make object Nudge Left. 
[Nudge Right]：Make object Nudge Right. 
[Align Left]：Make several object Align Lefts. 
[Align Vertical]：Make several object Align Vertical. 
[Align Right]：Make several object Align Right. 



 
[Align Top]：Make several object Align Top. 
[Align Horizontal Center]：Make several object Align Horizontal Center. 
[Align Bottom]：Make several object Align Bottom. 
[Make Same Width]：Make several object to the same Width. 
[Make Same Height]：Make several object to the same Height. 
[Make Same Size]：Make several object to the same size. 
[Group]：Make the object form one group. 
[Ungroup]：Cancel one group of groups. 
[Flip Vertical]：Flip up or down. 
[Flip Horizontal]：Flip right or left. 
[Rotate]：Rotate counterclockwise 90 degrees. 
 
3. Draw Toolbar: 

 
[Select]：In choosing the object state. 
[Attributes]：Change the attributes of the object. 
[Line]：Draw a line. 
[Rectangular]：Draw a rectangular. 
[Ellipse/Circle]：Draw a ellipse/circle. 
[Arc]：Draw a arc. 
[Text]：Add the text. 
[Bitmap]：Add the bitmap. 
[Scale]：Add the scale. 
[Polygon]：Draw a polygon. 



 
[Shape]：Add a Shape. 
[Alarm Scan]：Add alarm message. 
[System Message]：Change system information. 
[PLC Control]：Add PLC control elements. 
[Event Log]：Add event log object. 
[Data Transfer]：Periodically retrieve object's data from PLC. 
 
4. Part Toolbar 1 & 2: 
Picture Title Capability ID 

 
Bit Lamp Displays On or OFF shape to reflect current bit status in the 

PLC. 
BL-nnn 

 
Word 
Lamp 

Displays different shapes to reflect current register data in the 
PLC. 

WL-nnn 

 
Set Bit Changes the state of PLC bit address data. SB-nnn 

 
Set Word Writes specified data to a PLC word address. SW-nnn 

 
Toggle 
Switch 

Combination of bit lamp and set bit parts. TS-nnn 

 
Multi-State 
Switch 

Combination of word lamp and set word parts.  MS-nnn 

 
Function 
Key 

Creates a touch area to input data, change window, pop up or 
minimize a window or leave the memo. 

FK-nnn 

 
Moving 
Shape 

Moves a changeable object on the screen. MV-nnn 

 
Animation Moves a changeable object along predefined track on the screen 

or displays the different states of the object. 
AN-nnn 

 
Numeric 
Input 

Displays PLC registers data in numeric form and allows keypad 
input for changes. 

NI-nnn 

 
Numeric 
Data 

Displays the PLC register data only in numeric form. ND-nnn 

 
ASCII 
Input 

Displays the PLC register data in ASCII and accept keypad 
input. 

AI-nnn 

 
ASCII 
Data 

Displays only the PLC register data as ASCII characters. 
 

AD-nnn 

 
Bar Graph Displays the PLC register data as a bar graph. BG-nnn 

 
Meter 
Display 

Displays the PLC register data as an analog meter MD-nnn 



 

 
Indirect 
Window 

Calls a specific pop up window by a PLC word address. WP-nnn 

 
Direct 
Window 

Controls a preset pop up window by a PLC bit address. WC-nnn 

 
Alarm 
Display 

Displays alarm messages by word value in a defined location. AL-nnn 

 
   

 
Trend 
Display 

Periodically retrieve a group of PLC register data and displays 
in a trend graph. 

TD-nnn 

 
XY Plot Periodically retrieve a group of PLC register data and displays 

X values versus Y values. 
XY-nnn 

 
System 
messenger 

Set up system messenger SM-nnn 

 Recipe 
Action 

Downloads a block of registers to the controller or uploads  a 
block of registers to the HMI. 

RP-nnn 

 Event log Set up the warning incident in Event log EL-nnn 

 Event 
Display 

Displays prioritized and formatted alarm messages as triggered 
by bit status in a defined location. 

ED-nnn 

 
5. Object/Window Treebar: 
Object/Window Treebar lists the all objects/windows. The windows are numbered from 4,6,10 
to1999. Each window is displayed by window No. and window name. The window without a 
window name is an empty window. Right click the highlighted window and select Create to create a 
new window. Double click to open an existing window. The window with "*" in front of the 
window No. means it is open. Right click the highlighted window and select Delete or Close to 
delete or close an open window. 
EasyBuilder provides a good way in the Object Treebar to display the PLC address of each object. 
Click on the Objects Tab to view all the objects and of which corresponding PLC address on the 
Window number being displayed. 
Click on an object No. in the Treebar to highlight the object. The object can be positioned and 
edited. Double click on an object No. to pop up the attributes dialog of the object. 
To hide or display the Object/Window Treebar, Select [View]/[Object/Window Treebar] or simply 
press the Tab key. 



 

 
 
6. Cursor Position: 

 
Shows the current cursor position on the active screen and assistant statements. 



 

3.5.5 Menu [Option] 
 
1. Grid/Snap 
Grid is composed of many pixels on the screen for the alignment of the object. Enter X,Y pixels 
to change the grid density. Select Display checkbox to enable/disable grid visibility. 
Note: The grid isn’t showed on the screen after a downloaded. 
Select Option/  Grid/Snap, the following pop-up dialog appears: 

 
Spacing：Enter the space of the grid. Unit is dot, the default are 20 dots in both X and Y. 
Display：Enables/Disables grid visibility. 
Snap: As choose snap, the  mouse cursor will come from moving and revise and making the 
automatic corresponding net of Xiang of aline of object according to the site position on the screen. 
Fix objects：Fix the location of the object to prevent objects from inadvertently being moved. 
 
2. Window Property 
Set the environment of the screen. 
Select Window Property from the Option menu. 

 
Grid color：Set the Grid color. 
Object ID：Enables/Disables the object ID number from being displayed on an object. 



 
Using Function Key to make Shape Library: Please refer to Library Operations in Ch5.9. for further 
discussion. 
Jump to application mode when download down：Enables/Disables automatically forcing the 
MT500 toe the application mode after a download. 
Automatic save and compile at download and simulate：Enables/Disables automatically saving and 
compiling a project before a simulation or download. 
 
3. Language 
EasyBuilder supports several languages.。Should use the designated language, EasyBuilder must be 
installed under correct Window edition. For example, should support Chinese-traditional, 
EasyBuilder must be installed under Windows Chinese-traditional edition. At the same time , must 
install the designated font .Satisfied above, choose [Language ] and choose the correct language 
type in the function form [Option ], in this way , can use the suitable language type. 
 
 
3.5.6 Menu[Draw] 
 
1. Line/Rectangular/Ellipse/Circle/Arc/Polygon 

 
The following Attributes dialog box is displayed when drawing an object. 



 

 
The Frame attributes are used to set how the lines for the object are displayed. 
Select Line types – There are eight selections for the line or frame width. 
Select a Color– Select a color from the 256-color selection. 
 
The Interior attributes are for objects that can be filled. For objects that cannot be filled, this option 
is disabled. The filled attributes are not displayed if the Filled check box isn’t selected. 
If the Filled option is selected, the following attributes can be set: 
 
Select Interior colors – Select a color from the 256-color selection. 
Select Pattern – There are 26 different patterns available in the Pattern Style. 

 
The Pattern Style dialog pops up when the Pattern Style button is clicked. 
Note: The color window pops up when a color selection dialog is activated. One of the standard 
colors may be chosen or click on Customize color to access a full spectrum of color options. 



 

 
 
2. Text 
Click on the Text icon to display the Create Text Object dialog as below: 



 

 
Font: 
8, 16, 24, 32, 48, 64 and 96 font sizes are available. 
Align: 
When the text input for a display more than2 lines the alignment can be left, right or center justified. 
Color: 
Choose 32 colors out of 256 colors. Basic colors include the common use colors and customized 
colors allow you to choose your favorites.  
Content: 
Type in the characters to be displayed. When typing in the characters, press the ENTER key to 
move to a new line. 
 
3. Shape 
The function is to place a static shape no the screen, The procedure is as following: 

1) Select Shape from the Draw menu or click icon to pop up the dialog as below: 



 

 

2) Click on the Shape Library and select appropriate shape. 
Click OK. 



 

 
3) The display returns to the previous dialog. 

 



 
4) Click OK to place the shape. 

 
 
 
4. Bitmap 
Add a static bitmap on the screen by clicking Bitmap function. The procedure is the same as 
creating a shape. 
 
5. Scale 
Scale is useful with bar graph, meter or trend display. The types of scale are horizontal, vertical or 
curved. 

 
1. Click Scale icon. 
2. Left click to adjust the size of the object. 
3. Double click the selected object. 



 

 

Frame：Select the color and line style to be used for the Scale. 
Scale: Select the Style to be displayed: horizontal, vertical or curved Up, Down, Full, and ?. 
Disivion: Select the number of Divisions on the scale (Range from is 1 to 255). 
4. Fill in Style Tab. 
5. Fill in Profile tab to adjust size 
6. Click OK and place the object. 



 

 
The display of using a scale with meter shows as below: 



 

 
The operation shows…… 



 

 

 
 
 
3.5.7 Menu [Parts] 
 
The further details are discussed in Ch.6. 
 
 
 
 
3.5.8 Menu [Library] 
 
Please refer to Shape Library, Bitmap Library and Group Library in Ch.5 
 
 
 
 
 



 

3.5.9 Menu[Tools] 
 
There are five functions in Tools menu, please refer to Ch.12. 

 

 
 
 
 
3.5.10 Menu[Window] 

Please refer to Ch4. 

 
 
 
 
 
3.5.11 Menu[Help] 
 

 
1. Select Help Topics and the following dialog box appears: 



 

 

Key in the key words you are looking for or directly choose the index from the list. 
 
2. About EasyBuilder 
Select About EasyBuilder. The pop-up message box appears as follows: 

 

The EasyBuilder version and copy right are illustrate in the message box. 
 
 
 
 
 
 
 
 



 

3.6 On-line Simulation 
 
EB500 supports on-line simulation. The result of simulation ran on PC only with PLC is the same 
as that with both HMI and PLC. Two methods to execute on-line simulation: Through Simulator 
from EasyManager and the other is Simulator under EB500 (standard toolbar). The simulator 
directly retrieve the data from the PLC to simulate MT500 operation. By using on-line simulator 
when testing, it's save time caused for the repeated download. Before simulation, make sure the 
right connections between MT500 and the PLC and set the COM port and all parameters in the 
Easy Manager. 
1) Simulator from EasyManager. 
Enter EasyManager，set the all parameters and click Online Simulator, the following dialog pups 
up: 

 
Select the project and the click Open. Here we choose the existing a.eob file and a pop-up screen 
appears as follows: 



 

 

Realize on-line simulation like this. 
2) On-line simulation under EB500 
Enter EB500,and open the project you are going to simulate. Select Save /Compile in the Edit menu 

and select On-line simulator in the Tools menu or click  icon. 

 
 
3.7 Off-line Simulation 
 
EB500 supports Off-line simulation. Off-line simulation will not get the data from PLC, read the 
data only from the local address, so all datas are static. Off-line simulation can be execute from 
EB500 or from EasyManager. 
From EB500, Save the file first and then compile it. Select Off-line Simulator from Tools menu or 

click  icon to run the simulation. From EasyManager, select Offline Simulator to emulates the 

operation of a project on the PC screen. 
 
 



 

3.8 Assistant Tools 
EasyBuilder500 provides a set of powerful on-line Assistant Tools. Right click anywhere in the 
simulation screen, the pop-up movable menu appears: 

 

The following explain these functions in detail. 
1. Search 
Click Search，the following pop-up dialog appears: 



 

 

Check PLC checkbox and input PLC device and the range of the address. Click Search which 
shows all the objects using the specific PLC address. 



 

 

"W[0020] Ob[005] Ad[00010,03]-Move indicates:window No.[0020],object No.[005],address and 
bits[00010，03]-Move indicates Object name. Double clicking the highlighted data turns the display 
to the window on which the object is. The object is encompassed by white dotted line. 
In this way, any address of the object can be found. 
Similarly, select Part and choose the type you are looking for. Click Search and the display shows as 
below: 



 

 

Double clicking the highlighted data turns the display to the window on which the object is and 
show it. 
Click [on Copy to clipboard] , Object searching for now is duplicated to scrapbook,In this way you 
can clip and paste in any place. 
 
2. PLC Monitor 
Select PLC Monitor and the following dialog pops up: 



 

 

All current operating windows and the content are displayed by clicking on [Update Information]. 
If this procedure log-in AlarmScan and EventLog among them, then window 0 will run all the time. 
So long as AlarmScan and EventLog happen , the system will be dealt with at once. If use 
TrendDisplay or Data Transfer then window 1 will run all the time , in order to obtain the 
information that TrendDisplay or Data Transfer need. If use Message Board, because the 
information of the message board needs keeping all the time, the message board window will exist 
all the time. If use Common Window, then window 6 must exist all the time. In the graphic 
presentation above window 34, it is Open window at present. Open every item "+ ", there are 2 
kinds of to show the color all contents, among them a yellow one is the touch-sensitive screen to 
send  the data to COM port, a getting blue one data that inside punish. 
Block Capture: Display the communication data with PLC. 



 

 

 
3. System resource 
Select System resource to view all resources allocation of the inner system. 



 

 
MT500 adopts static resource allocation among them each basic window occupies 400kb, each 
pop-up window occupies 350kb,each fast window occupies 100kb,each common window 
occupies30kb,window 0 occupies 320kb. So how many components every window can be put at 
most should regard resource taken up in window as the accurate one in order to exceed. 
Timer taking one second as unit can't exceed 500 at most, taking 0.1 seconds as unit can't exceed 
100. 
Message Quene is the running condition of commands in the system. Sequence(2) is prior to 
sequence(1). 
 
4. Data Monitor 
Select [Data Monitor] can monitor the situation of the data. 



 

 

As the graph above,Pause is stop,All Objects is in order to monitor the operation of all,and can 
show the information of these objects to choose any kind or several kinds of object in Monitor 
Object, count is information ID. 
[WI/OI]:window number/object number. 
[Object]:object name. 
[Access Type]:Visit way(Read or Write). 
[Address Type]:Device name. 
[Address]:Device address. 
{Data(HEX)[low byte list first]}:Data format(Hexadecimal)[low byte list first/high byte list back 
end] 
 
5. Emulator Setting 
Select [Emulator Setting] to set the simulation display. 



 

 

If bitmap background mode is selected, the display is as the following: 

 

 
If bitmap background mode is canceled, the display is as the following: 



 

 
All the displayed are the same. 
On the right of the Object Information, the types of the object are set; on the right, 
(Address)/(Frame)/(Small Font)/(Transparent)/(Object ID)/(Common Window)  
If Address，Frame and Object ID are selected, the display shows as below: 



 

 

6. Print 
Print Screen：Print the current screen. 
Print Screen Preview：Print preview the current screen.  
Print Screen to File：Save the current screen as a *.bmp file. 
Print Window：Print the current window(s). 
Print Window Preview：Print preview the current screen.  
Print Window to File：Save the current window as a *.bmp file. 
Page Setup：Set up the print format. 
Note: Al the printings are printed through Windows. 
 
7. Exit: Exit the current simulation screen or press Blank key to exit the program. 
 
8. Help: Can open the theme of helping. 
 
9.About: The explanation of the EB500 and copyright. 
 
 
 


